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This tutorial is a step-by-step guide to a few basic tasks in Adobe™ InDesign® 
2022 (InDesign). The audience is novice users who are technical and professional 
writing students at UNC Charlotte. The tutorial is written for Windows PC users 
and does not include instructions for use of InDesign on a Mac device.

The tutorial provides instructions on how to: 
1) set up, name, and save an InDesign document; 
2) create textboxes and fill them with placeholder text; 
3) create a heading style in a specific typographic style; 
4) apply the new heading style to headings in the document; 
5) create a paragraph style; 
6) apply the paragraph style to the text in a textbox; and 
7) use the parent page function to apply page numbers and a running header.

 The tutorial is simplified and customized to get students in UNC Charlotte 
courses quickly into using InDesign for their coursework. The students in these 
courses may have a wide range of experience with Adobe InDesign from no 
previous experience to advanced professional experience. These students are 
preparing for professional positions as technical writers, graphic designers, 
usability experts, and other related careers.

The tutorial is intended to be printed out or open on a different monitor or 
window next to a blank InDesign document and followed step-by-step as the 
student works through the tasks. By the end of the tutorial (which should take 25 
minutes to complete), students will be able to repeat the tasks independently and 
build their expertise with other tutorials that focus on other basic InDesign tasks.

Typographic Conventions:
Bold				    Panel, menu, and screen selections; e.g., Character.
“Quotation Marks”		 Selection on your computer not in InDesign; e.g., 		

					     “Desktop,” “File Name:”.
		

Introduction...
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Download and install Adobe InDesign on your computer.

Double-click the   desktop icon on your computer desktop, or, select

Creative Cloud            from your list of applications on your Windows  menu 
and open the latest version of InDesign from the list. Wait while the applica-
tion loads.

Double-click on Letter.

Create an InDesign Document...

2

3

4 A blank letter-sized document 		
will open.

1
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Click on the File drop-down menu and 
select Save As.

5

Click on the folder where you wish to save your document. (“Desktop”).6

Type a Name for the file in the “File name:” field. Click the “Save” button.7
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 Click on the white  on the vertical “Toolbar.”

Create a Textbox with Filler Text... 

1

2 Click in the document and 
hold down the mouse button 
while you drag down and to 
the right to create a textbox of 
approximately 3 inches by 3 
inches (20p by 20p).

 Right-click inside the textbox to bring up the fly out menu. 
 Left-click on Fill with Placeholder Text. 
 The textbox will be filled with lorem ipsum filler text.

textbox

3

Introduction: In this section, you will create a textbox and fill it with 
placeholder text (referred to as lorem ipsum, which allows you to visualize 
your layout and edit it before you insert the actual text and graphics.
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Creating a New HeadingStyle...

1. Create a new blank textbox at the 			
	 top of the page (following steps 1 and 2 		
	 under Create a Textbox above). In the 		
	 new textbox, type in the word “Heading” 	
	 and center it, using the center button 
	 found in Properties panel under 		
	 Paragraph. 

2. Make sure you have the Character 
	 Styles panel selected in the 			 
	 Properties panel. It is located next to the 	
	 Paragraph Styles panel.

1. Highlight “Heading.” Next, look at the 		
	 Character section in the Properties 		
	 panel. The Character section is 
	 the second section, underneath the 		
	 Appearance section.

2. You will see an icon that looks like  . 	
	 This is the icon for font size. Use the drop-	
	 down arrow to change the font size to 		
	 36pt.

You will now change the font size of the 
“Heading” text. 

Introduction: In this section, you will learn to create a heading style, so the 
headings will be consistent throughout the document.
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1. While the text is highlighted, 	
	 click the drop-down arrow of 	
	 the first Character search bar. 	
	 This is the font search bar. The 	
	 default font style is Minion 	
	 Pro. 

2. After clicking on the drop-down 	
	 arrow, move down the scroll bar 	
	 until you find Bell MT. Select it.
 

Next, you will change the font style.
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Now that you have changed the font style, you will now change the font to Bold/
Italic.

1. Underneath the first search bar, 
another search bar reads Regular.
Click on the down arrow and choose  
Italic, Bold, or Bold Italic. In the 
example below, Bold was selected 
for the Bell MT font. 

The text is in a new font style and in bold. 
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The final step of this task will be to change the color. Remember to keep the text 
highlighted.

 
1. Look at the Appearance section 

(above the Character section), 
which is where you can change 
the font color. Notice two white 
squares that have a red line 
running diagonally through each 
one. One will be titled Fill and one 
will be titled Stroke. In order to 
add color to the text, use the Fill 
option. Click on the square next to 
Fill. 

2. A smaller window appears that 
shows a variety of colors to choose 
from to apply to the text. For 
this practice, select the red that 
has the C=15 M=100 Y=100… 
properties. This will change the 
color of the text. 

Good work! You have now successfully changed the font size, style, bold/
italic, and color. Now that the changes have been made, you can name your 
new typographic style.
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Naming New Typographic Style...

Introduction: You now know how to change your font in various ways. The 
next step will be to name this new typographic style, which will make it easy to 
change all instances at once. Make sure that your “Heading” text is highlighted. 
You will also want to double check that you are still in the Character Styles 
panel in the Properties panel on the right. This is particularly important in 
naming your new style. 

1. In the Character Styles panel, you will see an A. icon like this.       Click on the 
A. icon. A list of options will appear. Click on the first option named Character 
Styles.

2. A new, smaller window will appear. Look down at the bottom panel of this 

new window for a small icon that is a square with a plus sign.   This is the 
Create New Styles icon. Click on it. 
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3. A new name will show up in the list, Character Style 1. Double-click 		
	 Character Style 1 and a new window will open. 

4. Replace the name Character Style 1 with a new name for the typographic 	
	 style.  

5. In order to check this, look at the left panel and find the names Basic 
Character Formats and Character Color. Click on each option on the 
menu, starting with Basic Character Formats. Verify the selections for 
size, font style, and bold/italic. 

Warning: Before you rename, check that the properties you applied to the 
new font type have remained the same. Otherwise, all of your hard work won’t 
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 6. If everything is correct, click OK. Then, rename the font type in the 		
Style Name bar. In the example, the new style is named with the default 	
Character Styles 1.  

7. Once you rename the new typographic style, click OK to save and then close 
the Character Styles panel. Notice that the new font type is visible in the 
Properties panel under the Character Styles panel. 

Congratulations! You have now learned how to make a new typographic 
style and name it! Now you can move on to the next step!
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Creating a Paragraph Style...
Introduction: In this section, you will create a paragraph style that will apply 
the same formatting to all of the paragraphs to which it is applied.

Select and highlight some text as previously demonstrated.
  
Open the Paragraph Styles panel on the right side. 
 

Click on the  in the lower right corner.  
 
 
 
 
 
 
 

Double-click on “Paragraph Style 1,” which appears in the middle of the panel. 
 
In the Paragraph Style Options box that appears, replace “Paragraph Style 1” 
in the field next to Style Name: with a descriptive name for your new paragraph 
style such as text, text bold, heading, etc. 

1

2

4

5

3



Page 14

InDesign: Text, Styles, and Page Numbering

Click on Basic Character Formats and make changes to customize your new 
paragraph style such as font family, font style, and size.

Set up other Formats in the Paragraph Style Options panel and click OK at 
the bottom right corner.

6

7
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Highlight some text. 

Single-click on the name of the style you saved in the Paragraph Styles panel. 	
	 Your text will change to that paragraph style.

Applying a Paragraph Style

Congratulations! You have now learned how to make, name, and apply a 
new paragraph style! Now you can move on to the next step, creating a parent 
page!

8

9
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With the A-Parent still highlighted, create a textbox large enough to hold 	
	 the longest page number and any text you want to appear with it. Position 	
	 the textbox where you want the page number to appear, normally in the 	
	 lower-right margin of the document.

In the page number textbox, add any text that will come before or after the 	
	 page number (such as “Page ”) and format it using the Paragraph Style 	
	 set up previously.

Position the insertion point where the page number should appear, and 
from the Type drop-down menu select Insert Special Character > 
Markers > Current Page Number. See image below.

Create a Parent Page...

On the upper right side of 
the InDesign document 
screen, 	click on the Pages panel. 
If the Pages panel is not showing, 
click on the Window drop-down 
menu and click on Pages.

Double-click on A-Parent in the 
Pages panel to display the Parent 
Page.

1

1

2

2

Add Automatic Page Numbers...

3

Introduction: A Parent (or Master) Page is a nonprinting page that 
serves as a template that can be applied to some or all of the pages 
in your document. Parent pages contain text and graphic elements 
like page numbers, headers, footers, etc. that you want on all or most 
pages. You can have as many parent pages as desired and apply them 
to individual or groups of pages. (Adobe replaced Master with Parent 
early in 2022).
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A running head is a heading printed at the top 
of each page of a book or chapter.
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Right-click on a page to which 	
you want to apply the Parent 
Page in the Pages panel.

Select Apply Parent to 
Pages. 	Apply the Parent Page 
to any or all pages.

1

2

Apply the Parent to your Pages...

With the A-Parent still highlighted, create a textbox large enough to hold 	
	 all the text of the running head in the desired location, usually above the 	
	 frame of the document in the margin and aligned right. 

Type the text to appear at the top of every page. Format it using the 		
	 Paragraph Style set up previously. 

2

1

Add a Running Head...

Congratulations! You have now learned how to add page numbers, a 
running head, and a parent to your InDesign document! 
Congratulations! You have now learned how to add page numbers, a 
running head, and a parent to your InDesign document! 
Congratulations! You have now learned how to add page numbers, a 
running head, and a parent to your InDesign document! 
Congratulations! You have now learned how to add page numbers, a 
running head, and a parent to your InDesign document! 

Introduction: In this section, you will create a running head, which is a text 
block that appears on every page in the same position in the margin outside 
the main layout. It allows a label or page numbers to be applied to the whole 
document or a section.

Introduction: In this section, you will create a running head, which is a text 
block that appears on every page in the same position in the margin outside 
the main layout. It allows a label or page numbers to be applied to the whole 
document or a section.

Introduction: In this section, you will apply the Parent you created to the 
desired pages, so all its specifications will automatically be applied to them.
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You have successfully completed this tutorial!

Conclusion...

In this tutorial for novice technical writing students, you learned how to perform 
the following tasks in Adobe™ InDesign® 2022 on a Windows PC or laptop 
device: 

1) set up, name, and save an InDesign document; 
2) create textboxes and fill them with placeholder text; 
3) create a heading style in a specific typographic style; 
4) apply the new heading style to headings in the document; 
5) create a paragraph style; 
6) apply the paragraph style to the text in a textbox; and 
7) use the parent page function to apply page numbers and a running header.

 If you need additional information on how to use InDesign, visit the Adobe 
InDesign User Guide, which is continuously updated. 


